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 This file documents the scripts prepared by SSB BART Group for use with Logger Pro 3.6. These scripts were tested with JAWS 7.1, 8.0, and 9.0 and with Logger Pro

3.5, 3.6.0, and 3.6.1. They may work with JAWS versions as far back as 6.0, but this is not verified. These scripts may also work with later Logger Pro

Versions but will not work well with older ones. Some features, such as complete announcement of tables and live sensor readings, will not work as well

In Logger Pro versions older than 3.6.1.  

Installing JAWS Scripts

The JAWS scripts can be downloaded from the ILAB web site at: http://ilab.psu.edu. Be sure to download the zip file for Logger Pro 3.6.1. Once this file has been successfully downloaded, JAWS must be running prior to the user clicking on the zip file to run the automatic installer, which will place all of the necessary script files in the script folder under, Explore my settings.”
The JAWS Command Key System

How It Works

 Most JAWS commands implemented for LoggerPro consist of a prefix key followed by one or more separate keystrokes.  This allows a large number of commands

Without conflicting with LoggerPro's native commands.  This multi-key system works very much like a set of standard Windows menus in that commands are

Grouped into logical sets. For example, commands that deal with sensors begin with the Command key followed by the letter S.  In this document, such a

Sequence will be written as "Command S."  

 The prefix key that starts JAWS commands, which will from now on be called the "Command" key, is the left square bracket ([).  If it becomes necessary

To type a left bracket into LoggerPro itself, it can be done simply by pressing it twice in succession.  Keys typed after the Command key will only be

Seen by JAWS, not by LoggerPro, until the key sequence is exited.  

 Some key sequences exit when finished, like Windows menus also do. For convenience though, some do not.  For example, the first sensor's current live reading

Can be announced via Command S 1.  Typing digits right after the 1 will continue to announce other sensor readings.  Pressing any key that is not part

Of a sequence will exit the sequence, though Esc is the preferred method for exiting a sequence that does not exit automatically when finished.  JAWS will

Play a short door-closing sound whenever a command sequence exits, so the user will be ware that the sequence is completed and keys will again behave normally.

 There are a few JAWS commands for LoggerPro that use the more conventional single-keystroke approach. Also, most of the multi-key sequences have parallel

Conventional commands for those more accustomed to that approach.  The single-key versions of commands, which tend to be Ctrl+Shift with letters and numbers,

Will be listed in the 

JAWS Command Reference

 Section of this document.  

Keyboard Help for Key Sequences

 There is a help system for the key sequences just described.  To explore key sequences, press the Command key and then use Tab to move through the list

Of keys you could type next. This is much like arrowing through a Windows menu. Shift+Tab will move backward through the available keystrokes, and JAWSKey+Tab

(Or Insert+Tab) will repeat the most recently described keystroke.  This help system works at all levels of key sequences, so you could, for example, type

Command S and then use Tab to hear about all the commands available that relate to sensors.  

How to Use LoggerPro with JAWS and the Scripts

 This section is intended to help users get started quickly with LoggerPro using these scripts.  This section is organized by task.  Tasks appear as level

3 HTML headings, so JAWS users can use H or the number 3 to move from task to task efficiently.  

Connecting and Testing Sensors

Command S S will give a quick list of sensors that LoggerPro has noticed.  Command S L will also list sensors but with full names and current values for

Those that provide live readings.  Typing Command S Shift+L will bring up the sensor list in a JAWS virtual buffer for easy review.  If you are working

With a new data set, these commands will help you determine which sensors are connected and set up correctly.  

 If you are working with a pre-existing data set, the sensors listed by the above commands will be the sensors that were attached when the data set was

Created, not necessarily the sensors that are currently attached.  To get a list of currently attached sensors, create a new data set (this requirement

Applies with or without JAWS).  

 One way to access a sensor's setup screen is to click on its toolbar item near the top of the screen.  Command S Shift+S will activate the JAWS cursor

And place it on the row of sensor readings, making it easier to find a particular sensor for setup.  (This feature will only work if "Large Toolbar Buttons"

Is left unchecked in File > Preferences.)  

 Some sensors, when connected, cause LoggerPro to add a corresponding digital meter object to the current page.  You can use Ctrl+Tab to move through the

Available page objects, or Command O Ctrl+L

 To pick one from a JAWS list dialog.  Leaving focus on a digital meter will cause JAWS to provide real-time announcements of the corresponding sensors
Value as it changes. The right mouse button JAWS command, or the Menu key (sometimes also called the Applications or Context Menu key), provides another

Way to reach sensor setup dialogs if pressed while a sensor's meter is in focus.  

Command S and then a number from the number row will read specific sensor names and values. Shifting the number will let you set up automatic continuous

Announcement of a sensor's live readings.  For example, Command S 3 will read the third sensor's value, and Command S Shift+3 will bring up a dialog box

allowing you to set up sensor 3 for automatic continuous announcement of readings. To disable automatic continuous announcement of a sensor's readings,

Just bring up the setup box again, and then cancel it with Esc. Note that this method of automating sensor reading announcements will repeat the sensor's value

At specified intervals whether it has changed or not, whereas the above digital meter method will say nothing until the sensor's value actually changes.

 In the LabPro Setup dialog, Command S S will list all LabPro channels and announce what is attached to each.  Command S Shift+S will present this information

In a JAWS list box instead of just reading it aloud.  

Starting and Stopping Collection

Command S S will indicate whether data is currently being collected, in addition to listing sensors. JAWS will also announce automatically when collection

Starts and stops. The announcements may be slightly delayed if data collection significantly impacts the CPU.  

 Use JAWSKey+Tab before starting collection to make sure focus is not on a data table.  If it is, use Ctrl+Tab to move focus to a different item on the

Current page.  Collecting while in a data table may produce a lot of extra speech as the table continuously expands.  

 The Space bar usually turns data collection on or off but may not work in a data table and sometimes fails to stop collection even when focus is not in

A table.  Command S C, or Ctrl+Shift+C, will work everywhere and will better announce what is happening.  

Managing Objects on a Page

Ctrl+Tab will move cyclically through the objects on the current page, announcing each object as it acquires focus. JAWSKey+Tab will repeat the currently

Focused object's information, and a double 

JAWSKey+Tab will bring details about this object into a JAWS virtual buffer for easy review.  

Command F followed by a digit will read a specific field of information about the currently focused object.  This is most useful with statistical objects

As a way of quickly checking specific statistical values.  For example, Command F 3 will read the third field of information about the currently focused

Object.  If that object is a statistical object, the third field might be the minimum Y-axis value and where on the X axis it occurred.  

 When an object is in focus, there will be a corresponding option in the Options menu available that provides access to the object's properties.  Use this

To set up any special settings for the object, such as column names for tables, axis specifications for graphs, etc. The right mouse button command or

The Menu key can be used to gain access to the object's properties as well, but it may first be necessary to bring the object to the front of the Z order

So it is not covered by other objects. This can be done with Command O F.  Using the Options menu should avoid this issue though, so the Options menu is

The recommended approach.  

Command O L will list the objects on the current page, such as tables, graphs, digital meters, etc. LoggerPro adds objects automatically as sensors are

Connected, and users can add objects as well, such as thermometers, gauges, statistical objects, integrals, etc.  Command O Shift+L will bring up the object

List in the JAWS virtual buffer for easy review.  

Managing a Data Table

Note: Navigation may not begin on the first cell when you first try navigating in a particular table.  

 Use the four arrow keys to move among table cells. Use Ctrl+PgUp and Ctrl+PgDn to move up or down quickly 20 rows at a time. As you navigate up and down,

You will hear the row number and the current cell's value. When navigating left and right, you will hear the column name and the cell value. Note that

Left and right arrows wrap to new lines when you try to arrow past the left or right edge.  This is a LoggerPro behavior.  

Managing Pages in a Multi-Page Project

 Use PageUp and PageDown to move among pages of a multipage data window.  JAWS will announce the page number, page count, and page title (if any) when the

Page changes.  The Say Title command, 

JAWSKey+T will also announce this information when focus is in the data window. The Page menu contains many useful page-related options, including a way

To add pages and a way to jump directly to a specific page.  

Miscellaneous Tasks and Features

JAWSKey+F1, when typed in a data window, will bring up a JAWS virtual buffer containing a lot of information about the current page.  The following items

Are included: 

List of 3 items

• An indication of which page is currently showing, the page title if any, and the number of pages in the data window. 

• A list of all objects shown on the current page, with all information available about each.  For digital meters, this includes current readings at the

Time you typed JAWSKey+F1.  For statistical and analysis objects, this includes the data shown by those objects, such as integrals, slope equations, quadratic

Coefficients, etc.  This is more information for each object than shown by Command O L. 

• A list of all sensors associated with the current project (similar or identical to the information shown by Command S L). 

List end

 Use a double JAWSKey+F1 to display a help document in your default browser.  

 If you encounter a list or combo box that is hard to use because focus won't stay in it when you arrow among options, press F4 twice quickly and then select

Your choice from the JAWS list that pops up. (F4

 Was chosen because it naturally opens combo box dropdowns; pressing F4 once will do what it normally would have done without scripts running.)  

 The left and right mouse button keys will, if pressed when the PC cursor is active, click on the currently focused object (table, graph, meter, etc.).

 The Say Character, Say Word, Say Line, RouteJAWSToPC, and RouteInvisibleToPC commands will also address the currently focused object.  

User-Transparent Script Features

 The scripts improve JAWS' ability to name correctly a number of fields scattered throughout LoggerPro.  

 JAWS will automatically announce various error conditions, such as when trying to apply a Curve fit to a graph without selecting enough points or when

Trying to communicate with a Labpro on a port with nothing attached.  

 If a digital meter includes an alarm condition and that condition is met, the screen text in the meter turns red.  JAWS will begin saying "alarm!" before

Reading the meter's text in such a situation.  "Alarm!" should also appear in Braille for the meter where applicable. This feature requires LoggerPro 3.6.1

And will not work in older LoggerPro versions.  

 During import operations, JAWS will announce context-sensitive instructions and changes in the status of the process.  

 Some LoggerPro list controls do not read correctly without help, so the scripts include code to make these boxes behave normally with JAWS.  

 The scripts make the JAWS automatic graphics labeler work in LoggerPro though it otherwise would not.  It may be necessary to enable all graphics to be

Spoken before attempting this, though users should not have to do these themselves anyway. The scripts already include labels for the main tool bar at 16-bit

And 32-bit color depths and toolbar items can also be invoked from menus under the menu bar.  

 Several little tunings are included for the LoggerPro help system: Alt+B and Alt+LeftArrow go back to the previously shown help page, Alt+RightArrow does

The opposite just as in Internet Explorer, and JAWS should not repeat highlighted search terms while navigating through help pages right after you search

For key words.  

 JAWS will spell "T I" instead of saying "ti."  Several other custom pronunciation fixes are also included.  

JAWS Command Reference

 This section lists JAWS commands unique to LoggerPro.  Standard JAWS commands that are enhanced for LoggerPro but which function in other applications

Are not included here.  Examples of these include 

JAWSKey+Tab and JAWSKey+F1.  

Table with 4 columns and 18 rows

Category 

Function 

Command System Keystrokes 

Conventional Keystroke  

Command system help 

Cycle through and announce possible keystrokes at the current command level 

Tab or Shift+Tab at any level 

N/A    

Repeat the last-spoken command possibility 

JAWSKey+Tab 

N/A    

Exit the command system without executing a command 

Esc or any key that is not a command 

N/A  

Sensors 

Summarize current screen (includes quick sensor list) 

Command S S 

Ctrl+Shift+S    

Move mouse to sensor list on screen, or show LabPro channel list in a JAWS virtual view 

Command S Shift+S 

Ctrl+Shift+S twice quickly    

List connected sensors in detail 

Command S L 

Ctrl+Shift+A    

Say a specific sensor reading 

Command S digit 

Ctrl+Shift+digit    

Set up automatic announcement of sensor readings 

Command S Shift+digit 

Ctrl+Shift+digit twice quickly    

Toggle collection on/off 

Command S C 

Ctrl+Shift+C  

Objects 

Move currently selected object to front 

Command O F 

Ctrl+Shift+F    

Say the list of objects on the current page 

Command O L 

Ctrl+Shift+O    

Virtualized the list of objects on the current page 

Command O Shift+L 

Ctrl+Shift+O twice quickly    

List objects on the current page in a JAWS list box 

Command O Ctrl+L 

Ctrl+Shift+L  

Object fields 

Say the value of a specific field of information about the currently selected object 

Command F digit or Command F Shift+digit 

N/A  

Miscellaneous 

Skim down 20 rows in a data table 

N/A 

Ctrl+PgDn    

Skim up 20 rows in a data table 

N/A 

Ctrl+PgUp    

Open a combo box 

N/A 

F4 

Table end

Known Issues for Vernier's Attention

 The following issues would need to be addressed by Vernier in a future version of LoggerPro.  They can not be addressed, or at least not as safely or easily,

Via JAWS scripting.  

List of 7 items

• There are a few fields that are skipped by the Tab and Shift+Tab keys.  

• Some sets of radio buttons in LoggerPro do not allow arrow keys to select a choice.  For these, use of the JAWS cursor to click the desired option is

Required.  

• There is no known way to jump to the top or bottom of a table with keyboard commands.  

• Arrows can move focus to cells way below the bottom of existing data.  (This may be intentional and not a problem but is worth mentioning because it is

Unusual for table controls.)  

• Shift+Tab moves forward, not backward, through table cells. Arrows work as expected though.  

• Ctrl+Shift+Tab do not move through objects in the reverse order of Ctrl+Tab.  

• Left and right arrows, when pressed at the left and right edge of a row, respectively, wrap to the next row in the corresponding direction instead of

Stopping as is the case in many other applications.  This may be preferred by some users but is unusual enough to deserve mention. 

List end

Known Issues for Possible Future Scripting

 The following issues might be resolved by further JAWS scripting but did not make it into this release:  

List of 5 items

• Braille support is currently provided by placing the Braille display in Speech History mode.  This makes displaying sensor values and other crucial information

Very simple but is not the traditional approach to Braille support.  

• There will be a fair amount of extra speech if focus is left on a table during data collection in LoggerPro 3.6.1, because JAWS will try to report changes

In the focused object.  LoggerPro 3.6.1 provides the table row count, which changes every time a data sample is taken. To avoid this, avoid leaving focus

On the table during data collection.  

• Some fields, particularly in Options dialogs for the various object types such as text annotations, shapes, and meters, remain to be labeled for speech

And Braille.  

• Data window objects created via the following Insert submenu options have not been tested for accessibility due to lack of hardware during the scripting

Effort: 

List of 3 items nesting level 1

• Picture (two submenu options) 

• Video capture 

• Jell Analysis 

List end nesting level 1

• The following Analysis menu items and object types have not been explored for scripting: 

List of 6 items nesting level 1

• Examine 

• Tangent 

• Interpolation 

• Interpolation Calculator 

• Draw Prediction 

• Photo distance 

List end nesting level 1

list end
